Microsoft Memo

October 5, 1987

To: List

From: Tom Rudkin

Subject: Appearance of PowerPoint™ under Windows and Presentation Manager

Attached is a set of thirty-eight figures illustrating the planned appearance of PowerPoint running in the Windows 2.0 and Presentation Manager environments. They represent an adaptation of the existing Macintosh version of PowerPoint to the Windows/Presentation Manager user interface. See the note entitled “Specification Issues for Windows/Presentation Manager version of PowerPoint™” for a detailed discussion of the differences between the Windows/Presentation Manager version and the Macintosh version of the program. The captions on the figures describe the screen displays, menus, dialog boxes, etc. in enough detail that someone not already familiar with PowerPoint should still be able to understand what’s going on.

By the way, these figures were all done in PowerPoint on the Macintosh, except for some of the artwork, which was done in SuperPaint. PowerPoint printed them as thirty-eight separate slides on a LaserWriter.
This Windows display shows two PowerPoint windows on the “desktop,” along with the icon form of the MS-DOS Executive window. The front window contains the Columbus presentation, while the second window contains a new, untitled presentation. Both windows show slide 1 (the current slide) at 50% scale, which is (on this screen) the largest scale at which a slide can be shown in its entirety; hence 50% is the default scale for new presentations and this is the default window size for new presentations. The various parts of the window serve exactly the same purposes as their Macintosh counterparts.
This sample window shows the slide sorter in operation. Slide 1 is selected, denoted by the thick frame around its image. This is how the window would appear if you clicked the slide sorter button (top button above vertical scroll bar) from the previous figure.

In this view, entire slides or sets of slides may be cut/copied and pasted, either to the same or a different presentation. Slides may be reordered by dragging their images to a new position with the mouse.

Notice that the tools from the left edge of the slide view are not now present, since slides cannot be edited in this view.

If the window is resized to be wider or narrower, the miniature slide images are rearranged to fit the new width, possibly increasing or decreasing the number of images per row. You may scroll vertically to see more slides images.

To return to editing any slide, simply double click on its image.
This is the title sorter, an alternative to the slide sorter. As in that view, slides may be selected, cut or copied, and pasted into the same or a different presentation, and slides may be reordered by dragging their titles. Click over a title (right of the vertical bar) to select a slide; click between two slide numbers (left of the vertical bar) to select an insertion point; marquee around sequential slide numbers to select multiple slides.

Slide 1 is selected, denoted by the highlighted title. This is how the window would appear if you clicked the title sorter button (bottom button above vertical scroll bar) from the previous figure.

To return to editing any slide, simply double click on its title.
This figure shows three different cases of graphically-selected objects. At top left is a single selected rounded rectangle with an attached text label; it has a resize handle at each corner and a move bar on each edge. At top right is a single selected line; it has a resize handle at each end and move bars along its length. At bottom are two labelled boxes forming a multiple selection; each box has a move bar on each side, but no resize handles (which are always omitted in a multiple selection).
Current Route: sail Mediterranean, overland across Asia
   — A long and dangerous way to Cathay and the Indies
New Proposed Route: sail South of Africa, then Eastward
   — Even longer and more dangerous for Spanish traders
PowerPoint appends two commands to the standard Control menu. About PowerPoint... displays a dialog box giving the name of the program, version number, copyright information, authors' names, etc. and containing lots of graphic elements (including the Microsoft logo and the PowerPoint logo). Its exact layout is still to be designed, but it will be as similar as possible to its Macintosh counterpart.

Help... brings up a dialog box (see following figure) which allows you to open the help presentation into a new window. You use the normal PowerPoint commands for viewing slides in order to obtain help.

Note: the word "Title" on this slide is the default title of a new slide; the entire word is text-selected as it is when a slide is created, to allow you to immediately type the desired title for the new slide.
Help... brings up this dialog box, which describes generally how to use the help facility. Selecting Open Help File causes PowerPoint to open the help presentation into a new window, if it is not already open, or activates the help window if it is already open.
This figure shows the result of selecting the Open Help File button from the Help... dialog, starting from the situation shown in the first figure ("Main PowerPoint Screen"). The help presentation is shipped with the product in the file HELP.PP, saved in its title sorter view; therefore, it opens in this view. Each slide in the presentation contains a help topic, and also contains instructions for getting back to the title sorter in order to see the list of topics again.

While you may modify this presentation, there are safeguards against saving it over the original help file: the Save command in the help window always leads to the Save as... dialog but with no suggested name, so you must explicitly type the name of the help file and then confirm that you wish to replace the original.
Each of the commands of the **File** menu is described in a separate figure showing its dialog box.
The **New**... dialog offers the choice of creating a brand new presentation in which all of the defaults are those assigned by the program, or "cloning" the active presentation, which copies the slide master, notes master, handout page master, list of defined fonts, page size, and all other defaults from the active presentation—effectively copying the active presentation but discarding all of its (non-master) slides and notes pages. In either case, the new presentation is untitled. Cloning the active presentation is the default action of **New**...
The Open... dialog offers, by default, all files in the current directory which have extension '.PP' (PowerPoint's proposed file extension). If the check box at the bottom is checked, then after the file is opened into a new window it is made untitled and its association with the file from which it was read is discarded; hence the Save command from that window would lead to a Save as... dialog (with no suggested name), thus providing a way to create a new presentation by starting with an existing one without the risk of overwriting it.
Save as... Dialog

The Save as... dialog offers the current name of the presentation file as the suggested name to save under, but allows you to specify any file name and allows you to save in any directory on any drive. The two radio buttons control what is saved: the entire presentation, in PowerPoint's own format (the default), or pictures of all the slides (not notes pages) in a named "scrapbook." Since the concept of scrapbooks does not currently exist in Windows/Presentation Manager, we would have to import it from Macintosh to make this feasible. When this dialog appears as the result of closing an unsaved presentation, the second radio button is grayed.

October 1, 1987   PowerPoint™ on Windows/Presentation Manager

Page 12
When either **Save** or **Save as...** is executed for an untitled presentation (or for the help presentation), the same dialog as in the previous figure is displayed, except that no file name is suggested—you must type one.
When Paste from... is executed for a presentation in slide view (i.e. not viewing a sorter), a dialog box similar to the Open... dialog, except without the check box at the bottom, is displayed. It lists all the files whose contents can be pasted onto a slide—in this example, Windows Paint, Windows Metafile, and picture files. (on the Macintosh, MacPaint and PICT files can be pasted in this context). Precise list of file types is still to be determined.
When Paste from... is executed for a presentation in a sorter view, the same dialog box as in the previous figure is displayed. It lists all the files whose contents can be pasted into a sorter, i.e. from which slides can be created. In this example, it is assumed that the text files contain outlines, from which bullet charts can be made. Precise list of file types is still to be determined. The bottom dialog box controls where the text from the file is placed: slides and/or notes pages.

Options:
- Open File Name: C:\IDEAS
- Directory: [A:] [B:]
- Put text on:
  - slides only
  - notes pages only
  - both slides and notes pages

October 1, 1987  PowerPoint™ on Windows/Presentation Manager  Page 15
Page Setup... controls the shape and size of the slides and the starting slide number. The first 2 radio buttons specify common aspect ratios; PowerPoint computes actual size as the closest "round" numbers that fit on the page and satisfy the given ratio. The last radio button permits any custom slide size up to the printable area of the page. We assume that orientation (landscape vs. portrait) is selected on the printer-specific Printer Setup... dialog.

Select Numbering and Slide Shape on the Page

Number Slides Starting With: 1

Slide Dimensions:
- Overhead Shape (3:4)
- 35mm Shape (2:3)
- Size: 7.5 in Tall by 10.0 in Wide
- Screen Size: Pixels Tall by Pixels Wide
Print... dialog allows you to specify what to print (slides, notes, or various kinds of handouts, in any combination), which slides to print, how many copies, and whether or not to collate multiple copies.
Printer Setup... allows you to choose the printer to use from within PowerPoint, rather than having to use the Printer... command in the Control Panel window. The Setup... button leads to a device-specific dialog for setting up the chosen printer; for example, for a PostScript Printer you may specify paper size (U.S. Letter, etc.) and orientation (landscape or portrait), among other things, on the setup dialog. (Since these dialogs are device specific and not supplied by PowerPoint, no example is shown in these figures.)
The Slide Show... dialog controls how the slide show operates and provides help on the keys that may be used during the slide show. If manual advance is selected, you must use the mouse or keyboard to change slides; otherwise slides are advanced automatically after the specified number of seconds (but you may override that with the mouse or keyboard). If the check box is checked, then slide 1 is shown after the last slide and the only way to stop is to press the escape key; otherwise the slide show terminates after showing the last slide.
The top five commands on the Edit menu do the obvious thing to the selected text, object(s), or slide(s). **Paste as Picture** pastes the contents of the clipboard as a single picture onto a slide, whereas **Paste** pastes individual objects. **Paste Link**, if implemented, will retain a link to the source of the data.

**Omit Master** causes the objects from the slide master or notes master not to appear on the current slide or its notes page. If master items are currently omitted, the command toggles to **Include Master**.

**Set as Title**... causes the selected object—which must be capable of containing text—to become the title of the slide.

**New Slide** creates a new slide. If the view is a sorter, the slide is created at the insertion point. If the view is the current slide or its notes page, it is created following the current one, and the new one becomes current. If the view is a master, the new slide is #1.
The top four commands on the View menu set the scale at which to view slides, notes pages, or the slide sorter (depending on what is currently on view). In a slide sorter, Full Size means that miniature slide images are about 22% of a full-sized slide, and the other sizes are reductions from that. In this example, slides are currently viewed at half size (denoted by the checkmark).

The bottom seven commands control what to view: the current slide (in this example, slide #1), the current slide's notes page, one of the three masters, or one of the two sorters. The checkmark means slide #1 is currently on view.
The **Style** menu allows you to set the typeface (aka font), type point size, color, and style of text. Styles appear directly on the menu, but you must bring up a dialog to change typeface, size, or color (these correspond to submenus on the Macintosh).

You may add additional fonts (typefaces plus sizes) to the list near the bottom of the menu, or delete, modify, or reorder them using the **Other Fonts...** command. The two listed here are typical defaults for a brand new presentation: 24-pt for titles and 18-pt for other text. In this example, the current text selection is all bold 24-pt Helv, which is the default for the title of new slides (unless modified in the slide master’s title).
The **Font...** dialog contains a list of all fonts (aka typefaces) installed under Windows/Presentation Manager. When the dialog comes up, the font of the current text selection is highlighted, if the entire selection is the same font. In this example, the current text selection is all **Helv**.

You can change the font of the selection by choosing a new name in the list and clicking **OK**, or by just double-clicking the name. This is a shortcut for changing the font without having to install it (along with a size) on the menu using **Other Fonts....**
The **Size...** dialog contains a fixed list of type sizes. When the dialog comes up, the size of the current text selection is highlighted, if the entire selection is the same size and if the size is in the list. In this example, the current text selection is all 24 pt.

You can change the type size of the selected text by choosing a new number in the list and clicking OK, or by just double-clicking the number. This is a shortcut for changing the size without having to install it (along with a typeface) on the menu using **Other Fonts...**. If the size you want is not in the list, you must use **Other Fonts...**.

The type-in field allows you to specify any arbitrary type size (within some range, such as 1 to 187 points). When the dialog comes up, this field shows the size of the current text selection, if the entire selection is the same size.
The Color... dialog contains the list of colors you have chosen for this presentation (in this figure, different gray patterns are used to represent colors, and black and white represent themselves). When the dialog comes up, the color of the current text selection is denoted by a gray border around it, if the entire selection is the same color. In this example, the current text selection is all black.

You can change the text color of the selection by choosing a new color in the list and clicking OK, or by just double-clicking the color.
Other Fonts... allows you to add new fonts to the Style menu, change or delete an existing font, or reorder them (by dragging an item in the list to a new position). Each font has a default style and color also. If you change one of the fonts in the list to a new typeface, size, style, and/or color, then all text in the presentation that was set to that font is also changed. In the example, 12-pt Roman and 18-pt Tms Rmn have been added since the dialog was opened; they appear on the menu next time it is pulled down.
The **Text** menu controls properties of text that affect paragraphs or entire text objects. The top four commands set the alignment of text within an individual paragraph in a text box, or within an entire label object. (**Justify** is only available in text boxes.) In the example, the selected paragraph is left-aligned (the insertion point is at the end of the last line).

The remaining commands apply only to text boxes. The two **Indent** commands move the selected paragraphs left or right one level of indent, according to the indent markers on the text ruler. The next command shows the text ruler on the selected text box (it is shown in this example). **Line Spacing...** controls the spacing within and between paragraphs and is described in a separate figure showing its dialog box. **Set as Default...** causes the ruler and line spacing of the selected text box to become the default, used when creating a new text box.
Line Spacing... allows you to set the spacing between lines (expressed as a multiple of the height of a line of text) and between paragraphs (expressed as a multiple of the spacing between lines). You may change the spacing for paragraphs at any single indent level individually, or for all levels at once. In the example, lines within all paragraphs are "single spaced," and paragraphs are separated by an extra half line.

Line Spacing

- Change spacing for all outline levels, or change only one level:
  - 01 02 03 04 05

Spacing between lines: [1.0]
Spacing between Paragraphs: [1.5]

Before a Sublevel
- Use paragraph spacing from this level.
- Use paragraph spacing from the sub-level.

[OK] [Cancel]
The **Draw** menu controls graphical properties of objects. The top five commands are attributes that may be turned on or off for each object, controlling whether the object hides objects beneath it, whether a frame is drawn around it, whether its interior is filled, whether it is given a drop-shadow, and whether its size is automatically adjusted to fit whatever text it contains. The lozenge next to **Framed** means no object is currently selected and the framed attribute is on by default for new objects; if this cannot be implemented in Windows/Presentation Manager, we will use checkmarks for this purpose as well as for indicating properties of the current selection.

The middle set of commands bring up dialog boxes to select other graphical attributes; these correspond to submenus on the Macintosh.

The bottom three commands enable or disable three drawing aids: a 1/12-inch grid that objects snap to, magnetic guides for measuring and aligning objects, and edges that appear on screen only for delimiting the extent of objects that have no frames.
A filled box object's pattern is used to fill its interior; a framed but unfilled box object's pattern is applied to the frame; a line's pattern is used when drawing the line. The **Pattern**... dialog contains a fixed list of patterns. When the dialog comes up, the pattern of the currently-selected object(s) is checkmarked, if the entire selection has the same pattern, or is marked with a lozenge if there is no selection to show the default for new objects (as in this example). You can change the pattern by selecting a new one and clicking OK, or by double-clicking on the pattern. On this dialog box, the patterns are drawn using the current fill or line color and the pattern contrast color (see **Color** menu).
A framed box object’s line style is used to draw its frame; a line object is drawn in its line style. The Line Style... dialog contains a fixed list of line styles. When the dialog comes up, the line style of the currently-selected object(s) is checkmarked, if the entire selection has the same style, or is marked with a lozenge if there is no selection to show the default for new objects (as in this example). You can change the line style by selecting a new one and clicking OK, or by double-clicking on the style.
The **Arrowheads...** dialog controls whether a line object has zero, one, or two arrowheads at its ends. When the dialog comes up, the arrowhead style of the currently-selected object(s) is checkmarked, if the entire selection is the same style, or is marked with a lozenge if there is no selection to show the default for new lines (as in this example). The command is gray if there is a selection but it contains no line objects. You can change the arrowhead style by selecting a new one and clicking OK, or by double-clicking on the style.
The **Color** menu controls the colors of objects other than text, and manages the palette of colors available to the presentation. The top four commands bring up dialog boxes to select the colors of different parts of objects, and the fifth command brings up a dialog box to select the background color for a slide; these correspond to submenus on the Macintosh.

The bottom two commands add colors to the presentation’s color palette, and allow you to modify the colors in complex ways. These commands are not yet completely designed for version 1.1 of Macintosh PowerPoint, and are not discussed further here.
The fill color of a filled object is used to color the black pixels of its pattern (which may of course be an entirely black pattern) when used to fill the interior of the object.

The Fill... dialog contains the list of colors you have chosen for this presentation. When the dialog comes up, the fill color of the currently-selected object(s) is denoted by a gray border around it, if the entire selection has the same fill color; if there is no selection, the default for new objects is so marked. In this example, black—the default fill color—is marked.

You can change the fill color by selecting a new one and clicking OK, or by double-clicking on the color. When you do so, the Filled attribute on the Draw menu is automatically turned on also.
The line color of a framed but unfilled box object and of a line is used to color the black pixels of its pattern (which may of course be an entirely black pattern) when used to draw the frame or the line. The line color of a framed and filled box object is used to color its frame solidly.

The Line... dialog contains the list of colors you have chosen for this presentation. When the dialog comes up, the line color of the currently-selected object(s) is denoted by a gray border around it, if the entire selection has the same line color; if there is no selection, the default for new objects is so marked. In this example, black—the default line color—is marked.

You can change the line color by selecting a new one and clicking OK, or by double-clicking on the color. When you do so, the Framed attribute on the Draw menu is automatically turned on also (except for any selected lines, to which it does not apply).
The shadow color of a shadowed box object is used to color the shadow.

The Shadow... dialog contains the list of colors you have chosen for this presentation. When the dialog comes up, the shadow color of the currently-selected object(s) is denoted by a gray border around it, if the entire selection has the same shadow color; if there is no selection, the default for new objects is so marked. In this example, black—the default shadow color—is marked.

You can change the shadow color by selecting a new one and clicking OK, or by double-clicking on the color.
The pattern contrast of a filled or framed box object and of a line object is used to color the white pixels of its pattern when used to fill the interior of the object, to frame the object, or to draw the line. (Note that if the pattern is all black—the default—then the pattern contrast color is not relevant.)

The **Pattern Contrast**... dialog contains the list of colors you have chosen for this presentation. When the dialog comes up, the pattern contrast color of the currently-selected object(s) is denoted by a gray border around it, if the entire selection has the same pattern contrast color; if there is no selection, the default for new objects is so marked. In this example, white—the default pattern contrast color—is marked.

You can change the pattern contrast color by selecting a new one and clicking OK, or by double-clicking on the color.
The **Background...** dialog contains the list of colors you have chosen for this presentation. When the dialog comes up, the background color of the slide or notes page on view is denoted by a gray border around it. The entire slide is filled with this color before its objects are drawn on it, and if any object is opaque, the area beneath it is filled with this color first before the object is drawn. In this example, white—the default background color—is marked.

You can change the background color for the current slide or notes page by selecting a new one and clicking OK, or by double-clicking on the color. You can also change the background color of all selected slides in the slide or title sorter in this way.